Branding Guide
Branding Guide of the
Appalachian Search and Rescue Conference

Appendix to Administrative Manual
Version 1.1
Approved by the Board of Directors 6 May 2017

Appalachian Search & Rescue Conference, Inc.
P.O. Box 400440, Newcomb Hall Station
Charlottesville, VA 22904

This work is licensed under the Attribution-ShareAlike 4.0 International License (CC BY-SA 4.0). To view a copy of this license, visit https://creativecommons.org/licenses/by-sa/4.0/ or send a letter to Creative Commons, 171 Second Street, Suite 300, San Francisco, California, 94105, USA.

This license lets others remix, tweak, and build upon your work even for commercial purposes, as long as they credit you and license their new creations under the identical terms. This license is often compared to “copyleft” free and open source software licenses. All new works based on yours will carry the same license, so any derivatives will also allow commercial use. This is the license used by Wikipedia, and is recommended for materials that would benefit from incorporating content from Wikipedia and similarly licensed projects.

Set in Scala Sans and Minion with InDesign

This document may be downloaded from http://archive.asrc.net
Contents

Introduction ................................................................. 5
Logo ................................................................. 5
Logo Colors .............................................................. 6
Orange background and orange line around star of life .............................................................. 6
Green mountains .......................................................... 6
Light blue sky ............................................................... 6
Dark blue star of life ..................................................... 6
Yellow snake on staff of Asclepius ....................................... 6
Silver staff of Asclepius ................................................... 6
Black letters and outline around staff of Asclepius .............................................................. 6
Stationery ................................................................. 6
Stationery Logo ............................................................ 6
Stationery Typeface ........................................................ 7
Using in Microsoft Word (Windows or Mac) .............................................................. 7
Notes on Production ........................................................ 7
Governing Document Format ............................................... 7
Style ........................................................................ 9

“One-Pagers” ................................................................ 9

Slides ........................................................................ 12
Colors ...................................................................... 12
Guidelines for Slide Presentations ........................................ 12
Intellectual Property ........................................................ 13
Downloading ................................................................. 13
Overview of Slide Masters ................................................ 13
Video ......................................................................... 14
Historical Background ..................................................... 14
Technical Details ........................................................... 14
Editing in Word/RTF, Publishing with InDesign ......................... 14
Importing Word Files ....................................................... 15
Quick and Dirty Editing in InDesign .................................... 15
Extensive Editing in InDesign ............................................. 15
Running Headers ........................................................... 16
Bylaws-Specific Notes ....................................................... 16
Change History .............................................................. 16
Introduction

These days, big corporations often have very slick, very detailed branding manuals. They are expensive and much more than the ASRC needs. These guides are often 30-50 glossy pages with a great amount of detail. Why? Because having the logo always look the same, having the letterhead always look the same, and having official documents always look the same is a good thing. Consistency reassures customers and suppliers that the company is in solid shape and that they should continue dealing with it. A professional as well as consistent appearance reassures as well.

We already have some branding standards: the blue shirt and the ASRC patch, described in http://archive.asrc.net/ASRC-Admin/ASRC-Uniform/2013-03-05-ASRC-Uniform-Simple.pdf.

In the beginning of the ASRC, we had standard printed stationery. But over the past 40 years, things have changed. Now, you can just drag and drop an ASRC logo graphic into the top of a document and assume (wrongly) that it creates an official letterhead. The size, colors, position and quality of the logo therefore vary. A lot. The same thing occurs with our official documents, which also vary a lot in terms of margins, typeface, and other design elements such as big pretty pictures on the front page.

For the same reasons as for a large corporation, better branding would be good for the ASRC. We don’t need a slick glossy $10,000 35-page branding manual, but for the ASRC, at least a little bit of branding and standardization seems like a good idea. Thus, this document.

Note the use of a Creative Commons BY-SA license rather than a copyright. This specifically allows people to print and distribute without permission. It also permits people to make their own adaptations, provided they acknowledge that it was adapted from something the ASRC produced. This makes it more likely that those outside the ASRC will use it, which is good for ASRC branding.

Logo

The official ASRC logo is an electronic version in Adobe Illustrator .ai format. You can’t use this .ai format file in, for example, Microsoft Word, but it can and has been exported to other versions that you can use directly.

There are raster bitmap versions – .jpg and .png – but you shouldn’t use these unless absolutely necessary. Why? Because when enlarged they get jagged edges (pixelated).

However, there are vector resizable versions of the logo, which stay sharp no matter how much you enlarge them.

There are vector in .emf (Enhanced Windows Metafile) format, which you can drag and drop into many programs, including the current version of Microsoft Word. There are also .eps (encapsulated PostScript) that can be dragged and dropped into Adobe programs, such as Acrobat, and if printing something with a commercial printer, is one of the formats they prefer.

You can find this document and the logo files in the ASRC Archive, archive.asrc.net > ASRC-Admin > ASRC-Branding.

If you use the logo in a small size, the standard colors work well. But if you use a large size, such as on stationery, the logo’s color might be overwhelming. Here are examples of a small, full-color logo, and a larger one desaturated by 15%.”Desaturate” is to decrease the saturation, or colorfulness, of a graphic’s colors. They will look different in different contexts, such as on the cover of a manual.

1 There is a certain parallel with the standard meter bar, composed of an alloy of 90% platinum and 10% iridium, that was created in 1889 and resides in the Bureau International des Poids et Mesures in Sèvres, France.
or at the top of our letterhead. We recommend the desaturated one if you use a larger version of the logo.

**Logo Colors**

Here are proposed official colors for the ASRC logo, whether on a website or on a printed document. These have been visually matched with the colors of the original ASRC patch #069, except that the snake has been made more yellow to account for fading. This patch has been protected from ultraviolet light and at a controlled temperature since it was created about 40 years ago, which is a fancy way to say it was in a closet.

There is also a version of the logo with desaturated colors for use at large sizes. The desaturated RGB colors are also listed.

**Orange background and orange line around star of life**

- **PANTONE 158 C**
  - RGB: 232, 119, 54
  - LAB: L* 63.53 a* 43.77 b* 63.01
  - HTML: E87722
  - CMYK: 42, 45, 0, 42
  - HSL: 244, 29, 45
  - Desaturated RGB: 218, 127, 73

**Green mountains**

- **PANTONE 7740 C**
  - RGB: 58, 145, 63
  - LAB: L* 53.13 a* -40.74 b* 33.43
  - HTML: #A9F3
  - CMYK: 60, 0, 57, 43
  - HSL: 123, 43, 40
  - Desaturated RGB: 86, 147, 80

**Light blue sky**

- **PANTONE 291 C**
  - RGB: 155, 203, 235
  - LAB: L* 79.43 a* -8.06 b* -20.85
  - HTML: #9BCBEB
  - CMYK: 38, 4, 0, 0
  - HSL: 204, 67, 76
  - Desaturated RGB: 165, 203, 230

**Dark blue star of life**

- **PANTONE 7670 C**
  - RGB: 86, 82, 148
  - LAB: L* 37.63 a* 15.82 b* -36.55
  - HTML: #565294
  - CMYK: 42, 45, 0, 42
  - HSL: 244, 29, 45
  - Desaturated RGB: 98, 92, 146

**Yellow snake on staff of Asclepius**

- **PANTONE 394 C**
  - RGB: 237, 233, 57
  - LAB: L* 90.68 a* -11.91 b* 78.41
  - HTML: #EDE939
  - CMYK: 0, 2, 76, 7
  - HSL: 59, 83, 58
  - Desaturated RGB: 232, 229, 97

**Silver staff of Asclepius**

- **PANTONE Cool Gray 3 C**
  - RGB: 200, 201, 199
  - LAB: L*80.83 a*-0.71 b*-0.87
  - HTML: #C8C9C7
  - CMYK: 8, 5, 7, 16
  - HSL: 90, 2, 78
  - Desaturated RGB: 201, 201, 199

**Black letters and outline around staff of Asclepius**

- **PANTONE Black C**
  - RGB: 45, 41, 38
  - LAB: L*16.91 a*1.18 b* 2.62
  - HTML: #2D2926
  - CMYK: 63, 62, 59, 94
  - HSL: 26, 8, 16
  - Desaturated RGB: 35, 31, 32

**Stationery**

Gradually the original stationery went away, as people switched from typewriters to word processors. There have been grayscale versions of the ASRC logo, but the color logo has been dominant on ASRC documents over the past couple of decades. It’s also been much smaller than on the original stationery, perhaps since a subdued-color version was not readily available. The 15% desaturated version we use in the stationery header on a following page is about the same size as the black and white version on the original stationery; in color it was...
too much, but desaturated 15%, the size of the original seems to work even in color.

**Stationery Typeface**

Given the original typeface weight is not available in digital format, we can't have the original typeface, even if we wanted to. The ASRC chose the original News Gothic smallcaps typeface as it gave an impression of professionalism. There's nothing wrong with that, but things have changed over the past 40 years, and News Gothic now seems a bit stodgy and old-fashioned (see Background at end). We still need something that looks professional, but forward-looking too. It needs to be appropriate to an organization on the leading edge of search and rescue. We do want a sans-serif typeface, as this is standard for titling and headings. (Serifs are the little flanges on the ends of letters, such as in the capital letter i. The capital “I” in this typeface, the default Calibri of Microsoft Word, has no serifs, whereas the letter in the this ubiquitous Times New Roman serif typeface, has serifs on either end: “I”.)

We don't want something common and plebian like Arial, or even the more-common Microsoft Calibri that is used as a default text typeface by Microsoft Word. We want a sans-serif typeface, in the expectation that, unlike this document, people will match it with a common serif typeface such as Times New Roman, or better the serif typeface Georgia that Microsoft supplies as a default serif typeface. While Microsoft Word’s default of Calibri for both headings and text is reasonable, a more professional approach is to use a sans-serif typeface for a **title heading and then a serif typeface for text and text headings**, so we recommend you use Minion (which is what this Guide uses for text), Georgia or Times New Roman for the body of letters or other documents, not a clashing sans-serif font such as Calibri.

Selecting typefaces is notoriously controversial and many have strong preferences. In this case, we looked at the title/headings typeface used in the most famous modern book on typography: Robert Bringhurst’s *Elements of Typography*. It is Scala Sans and we have used it for the headers in this document and for the stationery headers on the next page.

**Using in Microsoft Word**

**Windows or Mac**

1. Drag and drop the file ASRC-letterhead.emf into the top of a blank document.
2. Right-click the graphic and select Size and Position.
3. Click the Text Wrapping tab, and select Behind Text.
4. Click the Position tab and then uncheck the Move with Text box.
5. Drag the graphic to the top of the document, then drag the corners so that the graphic fits across the entire page. Do not simply have it go from margin to margin; enlarge it to fit from one edge of the page to the other. You can set margins as desired, but we don't want the header to resize if you adjust the margins. By having the header across the entire page, it will look the same on every document.
6. Click in the document and press Enter a few times to get the text cursor to move down below the header and then start your letter.

**Notes on Production**

The logo was created in Adobe Illustrator. That was then imported into an Adobe InDesign document. The text was added and then converted to curves (“make into outlines”). The document was then exported to .eps (encapsulated PostScript) format. This was then converted to .emf (Windows Enhanced Metafile) that Microsoft Word can handle using https://cloudconvert.com/eps-to-emf.

**Governing Document Format**

For the governing documents of the ASRC, formatting should be as shown in this *Branding Guide*.

The *Branding Guide* was formatted in Adobe InDesign, currently the leading publishing software. Why use InDesign rather than Microsoft Word or Publisher? InDesign is much more sophisticated and can produce a much more professional looking document than Word or Publisher. It's designed by and for publishing professionals. That means it's harder to learn than Word, but that output is much better in many subtle ways.

The format for governing documents has many features that may not be apparent on a quick inspection, but that make the document look more professional.
Notes on Production

One example is that all of the text is laid out on a 12-point grid: the vertical distance between all of the text, both body and headings, is 12 points or a multiple of 12 points (1/6” or one pica).

Explaining these ways would require learning about publishing concepts such as leading (not “leeding” as in “leading a horse to water,” but “ledding” as in “lead-pipe cinch”), kerning, tracking and optical margins. That is beyond the scope this branding guide. If you are interested in those sorts of details, you should read Robert Bringhurst’s book The Elements of Typography, the most respected book on typography. Adobe hired Bringhurst to help with InDesign.

Working on drafts of documents is easier in Word than in InDesign. You can cut and paste text between InDesign and Word, so it’s possible to work on drafts in Word and then do the final formatting in InDesign. This does represent an additional step, but once the final format is set up in InDesign, it’s not hard to do.

This does require that the ASRC have one person who has InDesign and is willing to do the final formatting for the governing documents. However, the format is available in this document, and it can easily be used as a template for other documents.

Style

The ASRC has no rules for style. For best practices, the ASRC recommends following standard writing principles such as those Strunk and White’s Elements of Style. One of the most famous maxims from this book is “Omit Needless Words.” As an extension of this, you should use short words instead of long words wherever possible: also instead of additionally, use instead of utilize.

Another good short, simple reference for technical writing is Morris Bolsky’s Better Scientific and Technical Writing.

One recommendation specific to the ASRC: when writing about SAR teams in general, use teams; when writing about teams that are members of the ASRC, use the term Groups (capitalized) instead, as this is what is used in our governing documents.

“One-Pagers”

The ASRC is developing a series of “one-pagers,” which are a single sheet of paper, printed front and back, which provides “just-in-time” training. The recent inspiration was Carl Werntz’s idea in 2016 of one-pagers on safety topics, and the first one-pager was one he did on hydration, primarily for hot-weather operations.

If we go back further, Keith Conover produced an ASRC “Searcher Information Sheet” in 1975. The text from this first one-pager is what we’ve used to fill out the sample one-pager format on the next two pages.

These one-pagers might be used outside the ASRC, and even within the ASRC provide an opportunity to show the value of the ASRC to Group members. Thus, branding and professional design should be major considerations.

There is branding on both front and back:

- A relatively small ASRC logo. This is a vector version, rather than a raster bitmap, so it will print at full resolution of the printer or typesetter.
- A large but subdued (25% gray tint) “Appalachian Search and Rescue Conference” and the web address at the bottom.

There are design elements that contribute to a professional look:

- Typefaces: Scala Sans and Minion, as also used in other official ASRC documents styled using this Branding Guide.
- Main text set in 14 point on an 18 point grid: bigger text than in governing documents, for ease in reading in poor light. Wider than normal leading, ditto. 18 point spacing between paragraphs, ditto. Everything lines up nicely on an 18-point grid, which nobody is conscious of but is an important design element: looks more professional, easier to read.
- The blue text highlighting color matches the blue of the star of life in the ASRC log. It should print fine and be legible on monochrome printers, but looks even better when you see it on a computer screen or a version printed in color.

The text for one-pagers must fit in the allotted space.
Your assistance in this search operation is greatly appreciated. In order that this operation be conducted in a safe and efficient manner, we ask that you take careful note of the following instructions.

REGISTER at the designated spot. Please fill out the registration carefully and fully, since your team assignment will be based on this information.

REPORT to the staging area. If you have time to spare, take on some food and water, rest, and wait to be assigned to a team. Check to see that you have proper clothing and equipment to go out into the field; your team leader will check on this.

FOLLOW your Field Team Leader’s directions. He or she is responsible for your safety and for the quick and proper completion of your assigned task.

SIGN OUT! before you leave. A (presumably) lost searcher is just as much a problem as the lost victim. If you realize after you have left that you have forgotten to sign out, call U. Va. Police at (804) 924-7166 and leave a message.

If you should get lost, STAY PUT. Don’t make yourself a moving target.

PROTECT yourself from hypothermia by wearing the three Ws: wool, windproof and waterproof clothing. Nibble to keep your energy up.

AVOID heat exhaustion and heat stroke by drinking plenty of water.

**Saturation Search Methods**

You will probably be employed as a member of a team performing a saturation search. Such searches are difficult and time consuming, and require diligent effort in order to be complete. Usually all members of the field team form a line with spacing as given by the Team Leader. The line moves slowly forward, as each searcher scans the terrain for clues. Even a single footprint or candy wrapper may mean the difference between success and failure, so be alert.

Each time a clue is found, or a searcher requires a stop for some reason, he calls out “STOP!” which is passed up the line. Any searcher may stop the line. When it is time to continue, the Team Leader will check the readiness of the line. The question, “READY RIGHT?” or, “READY LEFT?” is passed to the ends, person by person. Any person who isn’t ready to move should not pass on the question to the next searcher.
If the end man gets the question, he will assume that everyone is ready to go. Then the end man, and only the end man, will start the answer, “RIGHT READY!” or, “LEFT READY!” relaying back toward the leader. The leader will then give the command to move.

While searching, you should pay careful attention to the area you are searching—be careful not to neglect the area between you and the next searcher, check under logs and in tangles of brush, Look backwards once in a while. Try to keep even with the line, but feel free to move back and forth in your section of the line to avoid logs or check out possible hiding places. Remember, however,

1) don’t neglect an area just because it looks rough or messy; call a stop and investigate, or ask the Team Leader to make a search of just that small area, and

2) try to keep the line spacing. Search lines have a tendency to compress themselves downhill. Don’t let this happen to your line.

Thank you for your participation and cooperation.

Telephone University of Virginia Police at (804) 924-7166. to leave messages after the search (lost or found equipment, forgotten
To preserve branding and professional appearance, we will not decrease text size or spacing to fit in more text. If the text (and any diagrams or other graphics) won't fit in the allotted space, then it's too much for a one-pager.

Slides

Slide presentations benefit from a professional appearance and consistency as much if not more than documents. Slide shows go back hundreds of years, to 17th century magic lanterns. Thirty-five millimeter (35mm) photographic transparencies came into use in the 1930s, and by the 1950s people had started boring friends and family with hours of blurry vacation slides. Slide shows really came into routine use for education and corporate presentations with the advent of the Kodak Carousel slide projector in 1965. By the 1980s corporations had realized the power of slide presentations and had full-time staff devoted to preparing slides for sales, executive presentation and educational lectures. Standardized backgrounds with corporate or institutional logos became required.

Microsoft’s introduction of PowerPoint in 1990 sounded the death-knell for the Carousel and 35mm slides, and despite competition, powerpoint has become a synonym for a computer-based “slide” presentation. We provide PowerPoint masters as all other presentation programs will accept them.

Even in this day of cheaper, lighter and brighter LCD, LED and laser projectors, the emphasis on corporate branding for “slides” continues, and for good reason.

Colors

There is good evidence that black text on white is the most readable on a computer screen, but with a projection in a relatively-dark room the glare from the projected white background may cause headaches. The same evidence shows that white text on a black or gray background is quite readable on a computer screen. However, viewing a projected image across a darkened room is not the same as reading text in a computer browser or a piece of paper right in front of your face.

Expert opinion says that for projected slides, a bluish background with white or yellow text is probably best. This provides the best legibility (of colored backgrounds and texts) and the least eyestrain. The combination of red and green, in particular, causes a strobing effect and is famous for nauseating viewers.

There are also psychological arguments for using a bluish background. A blue background tends to project calmness and professionalism, more so than a black or gray background. A blue background also contrasts perfectly with the orange around the edge of the ASRC logo. We could have used a plain blue background or a gradient with the ASRC logo in one corner. But the backgrounds we chose, one for title slides and a different one for main slides, provide a distinct appearance, and one of the goals of branding is to provide something that looks distinct.

Guidelines for Slide Presentations

In his essay The Cognitive Style of PowerPoint, Yale professor Edward Tufte explains how PowerPoint crashed a space shuttle (and now that we have your attention) can easily be misused. Some of the most important lessons there include:

- A slide presentation can foreshorten a complex subject and leave out important details.
- Projected slides have a low resolution compared to a piece of printed paper or even a lower-resolution computer screen in front of your face.
- A slide presentation has to be linear and inflexible; it’s hard to jump around based on interaction with your audience, which makes you unwilling to interact with your audience.
- Tufte is perhaps the world’s leading expert on the presentation of data (just the titles of some of his books should provide a clue: The Visual Display of Quantitative Information; Envisioning Information; Visual Explanations: Images and Quantities, Evidence and Narrative; and Beautiful Evidence.) He points out the deficiencies of PowerPoint’s data displays.
- Perhaps most importantly, Tufte has issues with making the audience read text on a wall. He doesn’t think it’s an effective teaching tool. He recommends using PowerPoint to show diagrams, illustrations, or photos.

A strictly Tufte-compliant slide show might consist of a series of graphics on a black background, broken up into sections by a few title slides. We provide a master title layout, and a section header layout.

Although we provide a variety of slide masters, it’s a best practice than you should use a totally black background for the graphics slides. There is no need to have the ASRC logo on each slide. The ASRC PowerPoint template provides a black-background master with only
a slide number.

If your audience needs to know how to spell a word, or you need to show some numbers, inserting a graphic into one of the slide masters that provides a title. But as a general rule, it is better to insert graphics into a slide with a black background.

To make a PowerPoint slide show more usable for others, without filling the presentation with text for the audience to read off of the wall, put detailed speaker’s notes in the notes field.

PowerPoint and other popular presentation software offer a mode where you can view the presenter’s notes on a laptop while the projector is showing the slide. Those who wish to use someone else’s slide show can read through the presenter’s notes you’ve entered to prepare for the presentation.

Intellectual Property

Those who create slide presentations for the ASRC should make sure that the slide presentation includes the Creative Commons license that we use and is part of the title slide master.

However, if you create slide presentation, you also deserve recognition. We recommend that you add your name to at least the first title slide where indicated. If the presentation is a joint project of your Group, you may want to put your Group’s name there instead.

If you don’t want your personal or Group name there, please remove the [and insert name here] from the footer.

Downloading

A Powerpoint file that you can use to create your own ASRC-branded slide presentation is available at http://archive.asrc.net/#IDASRC-Admin-ASRC-Branding.

Overview of Slide Masters

The branding on these slides consists of:

- **Background**: the backgrounds are professional ones that contrast nicely with the ASRC logo. There are separate backgrounds for title slides and standard slides. Please don’t change the background, except to use a black background with no graphics for images (photos, diagrams and the like). We adjusted the original non-title slide background to make it a bit darker and have less contrast; note that it seems to print darker than it appears on-screen or projected.

- **ASRC Logo**: a large logo appears at the top left of the title slide master, and a small ASRC logo at the top left on all the other slide masters. The ASRC “Appalachian Search and Rescue Conference” in the official Scala Sans typeface does not appear on these slide masters. We think the logo is enough branding, and adding text would be too much.

- **Text Size**: text on the masters is sized to be readable when projected on a wall. If you make text significantly smaller, people may have trouble reading it. Unsolicited advice: If you have the urge to put lots of small text on a slide – don’t. Prepare a handout with your text, or take the time to verbally explain the concept to your audience while showing an image without any text, or even just show a black slide.

- **Title Slide Master Text Color**: the most important text is in yellow, and we have replaced the old standard PowerPoint drop shadow with a contrasting outer glow with provides the needed contrast but is much more subtle. Subsidiary text is in dark blue with a white outer glow on the lighter blue background.

- **Non-Title Slide Master Text Color**: Since the non-title slide masters all have a darker blue background, the most important text is in a tint of yellow with a gray drop shadow. Outline text has a first-level with
**Video**

(reserved)

**Historical Background**

Things have changed since the ASRC was first founded in 1974. In those days, we had black and white stationery printed by a commercial printer. Gene Harrison hand-drew the logo design. The little line near the bottom is Gene’s initials and the date. The printer put “Appalachian Search & Rescue Conference” text right at the top in News Gothic in a heavy weight (Smallcaps, Black or Heavy), a typeface weight that has never been digitized and is no longer available. An example is below after the sample one-pager.

We chose the colors for the patch, which later became a color logo, from the thread colors the manufacturer had available. One this page is a scan of one of the original 100 numbered patches the ASRC had made. The staff in the center was of silvery metallic thread. The snake was originally a bit yellower but has faded to an orange shade over the past 40 years. We asked for silvery gold thread for the snake but they didn’t have any. Note that the letters in the logo and patch are not an actual font, but drafted so that the vertical portions of the letters are along radial lines out from the center of the logo.

**Technical Details**

For whoever is working on governance documents in InDesign, here are a few helpful hints.

**Editing in Word/RTF, Publishing with InDesign**

For most ASRC documents (but not this design-intensive Branding Guide) it makes sense to use Microsoft Word files for drafts for editing. Then, once the editing is all done, you import the Word file into InDesign for final formatting.

By far the best way to do this is to export a RTF file from InDesign, then edit that, and re-import into InDesign. If you select a particular section of a document in InDesign, you can export just that section for editing, and then paste it back in. For such RTF-format
drafts, there is no need for headers, footers, titles at the front, or anything except for the text itself, with no fancy formatting. Indeed, trying to do any formatting in Word just makes it harder to import the final product into InDesign. Here are a few important rules for edit the RTF documents:

- **Do** use the paragraph styles in the exported RTF file, if you create new sections. This makes importing the file back into InDesign a snap. These styles also make navigating the document a lot easier in Word, if you use the Navigation panel on the left (View > Show > Navigation Pane).

- **Don’t** separate your paragraphs with double carriage returns. **Don’t** press Enter twice between paragraphs. If you want more space in your draft, edit the Normal paragraph style to have more spacing (Home > Styles > right-click Normal > Modify > Format > Spacing > Line Spacing > Double). If you’ve already twiddled with the line spacing and overriding the Normal style, you may have to also do this: Home > Select > Select All > Paragraph > little button at bottom right > (set line spacing to double).

- **Don’t** use Enter and then a tab to format a paragraph, adjust the margins using the ruler instead.

- **Don’t** bother putting in the document “front material” such as the title, ASRC address, or copyright/ Creative Commons license. All that’s already in the InDesign document before we import the Word text.

### Importing Word Files

InDesign allows you to link Microsoft Word styles to InDesign styles to import an entire Word file. You do this in InDesign by using the menu options File > Place > click the Show Options box at the bottom > select the Word file to import > in the resulting dialog box, match up the styles, and if you wish, name and save the matching so you can use it again > Open. Despite working on it for many years, Adobe still hasn’t been able to fix all the bugs. Sometimes it works well, sometimes it doesn’t. That’s why exporting a RTF file and then editing that is the ideal way to update a document.

Make sure the styles in Word are based on (no style). If the styles are based on each other or on Normal, InDesign sees almost everything in the style as a local override.

Even if you do this, there will be a lot of local overrides. There is a button in the top panel of InDesign, underneath the Paragraph style box, which clears overrides. But an easier way to clear these overrides is to, as you assign InDesign styles to paragraphs, to Alt+click on the style in the Style Panel to apply the styles. This applies the style and overrides all those imported Word overrides. If there is bold text or italic text, this Alt+click will override this and eliminate the bolding or italicization, so for those particular paragraphs, it’s usually appropriate to click without holding the Alt key, but in general, you should tag paragraphs with the Alt+click method.

### Quick and Dirty Editing in InDesign

If you just need to change a small bit of text, you can simply edit the text in InDesign. But with bigger document and certain options turned on (see below), this can be very painfully slow. Instead, you can copy the text from InDesign into Word, edit it there, and then paste it back into InDesign. But if you just want to make a few edits here and there throughout a document, and you don’t want to export a RTF and then import it, consider the following convoluted but workable option to edit even a large document right in InDesign.

### Extensive Editing in InDesign

There are a couple of formatting options that add much to a professional appearance, but impact InDesign’s performance so much that editing text, even on a high-end workstation with a fast SSD hard drive, is almost impossible. There are some workarounds.

First, edit the H1 (heading #1) style > Keep Options > Start Paragraph > [change from the default Start Anywhere to on Next Page]. Having this set to Anywhere produced a much more professional looking document, but it is computationally intense and really slows down text editing. Once you’re done editing the text, **remember to change this back to Start Anywhere**.

This will make the document longer, so you may have to add some pages to see all the text, and then once done editing and you’ve changed this back to Start Anywhere, delete the extra blank pages at the end.

Another thing that slows text editing is the Balance Columns option. It does produce a much more professional appearance. You can turn it off temporarily for a single page. Right click the text frame on the page, and select Text Frame Options and then turn off Balance Columns. Remember to turn it back on when you’re done editing that page but **only** after you’ve changed that Start Paragraph > Start Anywhere option back on, as the text will probably move to a different page.
**Running Headers**

Running headers make it easier to tell where you are in a document.

If you have a header with both section and subsection for a printed document, you can have the section header in a more prominent position aligned away from the spine, and subsection aligned toward the spine. For a printed version, printed front-and-back and stapled or bound, this is enough to distinguish the two; this will certainly work well for those who print it off and insert it in a 3-ring binder. However, ASRC governing documents will likely more often be read online as a PDF, usually page-by-page rather than two-pages-per-view. Therefore, to distinguish the headers, the section header is in Scala Sans bold, and the subsection header is in Scala Sans light. To de-emphasize the headers and page number, which after all are usually less important than the text, they are all in a tint of gray rather than black.

Running headers are defined in an InDesign document's Master Pages. ASRC documents have two defined Type Variable, Section and Subsection. The Section variable is the text that has the HeadText1 character style applied; this character style does nothing to the text, but is a sign to pick up the text in a heading that has this character style applied to it and to insert it into the running header. Similarly, the Subsection Text Variable is defined as the text formatted with the HeadText2 character style. The disadvantage of using a character style for this is that you have to apply the character style to some text to get it to appear in the running header. It would be easier to assign the Section and Subsection type variables to a the paragraph style of a particular level of heading.

But the advantage of using a manually-applied character style – and this is important – is that you can apply the HeadText1 or HeadText2 character styles to just a portion of the heading. And given how the writers of ASRC documents like to use very long headings, it's often a good idea to select just a portion of the heading to appear in the running header. This way, you will have room in the header for both minor and major sections there.

On a master page, if you use the menu: Type > Text Variables > Insert Variable > Subsection, you will see something that looks like `<Subsection>` However, this is not the same as simply typing the letters for `<Subsection>` so don't confuse the two.

**Bylaws-Specific Notes**

Non-numbered paragraphs in the Bylaws generally format best with the 1.1 paragraph style, with a tab at the beginning.

The Word file of the Bylaws prior to the InDesign version did not use Word's automatic numbering; the numbering was all done by hand. For the first InDesign version of the Bylaws (2017-01-17), we didn't fix this, those numbers are still hard-coded in there. For the next major revision, we should fix this.

---

**Change History**

Available old versions and working drafts are posted in the ASRC Archive at [http://archive.asrc.net](http://archive.asrc.net).

**May 2017 (Version 1.1)**
- Added section on slideshow branding, with supplementary PowerPoint slide master set.
- Added Change History
- Additional editorial changes, including section and subsection headers and documentation on them.

**January 2017 (Version 1.0)**
- First version.